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1. INTRODUCTION   
This document describes how to install and operate the Pee Dee River and Atlantic 

Intracoastal Waterway Salinity Intrusion Model-Version 2 (PRISM-2). The PRISM-2 is a 
decision support system (DSS) built around a suite of empirical hydrologic models of the study 
area (fig. A1). Hydrologic behaviors in the study area have been measured at a number of 
streamgaging stations operated by the U.S. Geological Survey (USGS) since the mid-1980s.  
 

                                                           

 

Figure A1. Study area showing U.S. Geological Survey stream gaging station locations in South Carolina 
where flow, water level, and specific conductance were measured. 
 

2. INSTALLATION 
1. Create a folder called “PRISM2” at the top level of your C: drive. 
2. Extract all files from the distributed PRISM2-yyyymmdd.zip1 file. The WinZip™ file 

contains the following application files: 

1 yyyymmdd is the version date of the PRISM2 application to be installed. 
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• PRISM2-yyyymmdd.xls—a Microsoft Excel™ (Excel) spreadsheet application, 
• 18 files with an “.enn” extension—these are the artificial neural network (ANN) files, 
• NNCALC32.xll—a custom Excel add-in used to execute the *.enn files, 
• PRISM2UserGuide-yyyymmdd.doc—the Microsoft Word™ file that you are reading 

right now, and 
• ReadMe.txt—a text file with these installation instructions. 

3. Open your copy of Microsoft Excel™ for Office 2000™ (Excel). The version of Excel must 
be 2000 or newer. Ensure that the standard Excel Add-Ins listed below are installed and 
checked “available.”  

 
Analysis Toolpak 
Analysis Toolpak – VBA 

 
Add-Ins are accessed from Excel’s Tools menu. If any are missing, it may be 

necessary to install them from your Microsoft Office CD-ROM. 
4. Set the macro security level of Excel to either medium or low using Tools > Macro > 

Security. PRISM-2 uses VBA macros for a variety of purposes and must be able to execute 
them to operate correctly. 

5. Install the NNCALC32 custom Excel add-in that resides in the NNCALC folder described in 
Step 2. This may be accomplished by clicking on Tools > Add-Ins > Browse, then browsing 
to the PRISM2 folder you created, clicking on the NNCALC32 icon, then clicking OK. 

6. Open the PRISM2-yyyymmdd.xls Excel spreadsheet application. When Excel asks if you 
want to run macros, click “Enable Macros”; otherwise, PRISM-2 will not operate correctly. 

 
Select the “Run” worksheet (fig. A2). “Run” is the graphical user interface (GUI) 

component that allows the user to set up and run simulations. At the top of “Run” is a text 
box labeled “Where model files are located.” The model files are the *.enn files. Type in the 
fully qualified path name of the folder set up in Step 1 above, and save the Excel application 
using File > Save for the set up changes to be permanent. 

At lower right in the “Run” worksheet are a number of columns with headers containing 
specific conductance (SC). If many of the SC-related fields show numerical values and not 
“?” or an Excel or NNCALC32 error code, the application is properly configured and ready 
to use. If all of the SC-related fields show “?” or an error code, exit Excel™ and reload Excel 
and the PRISM application. 

An error code indicates that an ANN cannot execute because either the NNCALC32 add-
in is not installed per Step 5 or NNCALC32 cannot find *.enn files because the folder path 
name in the “Where model files are located” text box is incorrect.  

If you cannot get PRISM-2 to operate, re-check the configuration items in Steps 3–6 
above.  
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Figure A2. The “Run” worksheet, a component of Pee Dee River and Atlantic Intracoastal Waterway 
Salinity Intrusion Model (Version 2) graphical user interface. 

 

3. REMOVAL 
Delete the folder created to hold the PRISM-2 files and contents. 
 

4. OPERATION 
PRISM-2 is opened like any standard Excel workbook. Simply open the PRISM2-

yyyymmdd.xls file, and you begin. PRISM2 and its GUI includes a number of worksheets that 
are described in detail in the following sections. 

 

4.1. Variable Descriptions, Nomenclature, and “ReleaseNotes” Worksheet 

PRISM-2 refers to many input and output variables, usually in the form of column 
headers (fig. A3). Moving the cursor over a header marked with a red caret immediately above 
and to the right of the header will provide a description of the header variable.  
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Figure A3. Description of the variable QOTHERDm on the “Run” worksheet. 

 

Descriptions of variables are provided in the “ReleaseNotes” worksheet. This worksheet 
also describes the development history of  PRISM-2 and any new features or changes. 

Some of the prefixes, suffixes, and other modifiers that are used in variable names 
include 
• “D,” used as a suffix to indicate that a variable is a “daily” or 24-hour average; 
• “d,” used as a prefix to indicate that a variable is the difference between the values of  two 

variables; 
• “p,” used to indicate that the variable is a model prediction; 
• “m,” used to indicate that the value of a variable is either 

o an actual measurement or 
o a model prediction made using an actual measured flow (Q) at station 02131000 

(Q131000)  as an input value; 
• “u,” used to indicate that the value of a variable is either  

o a user-set or optimizer-set Q131000 value or 
o a model prediction made using a user-set or optimizer-set Q131000 input value. 

 

4.2. “Info” Worksheet 

The “Info” worksheet is automatically displayed when PRISM-2 is first loaded (fig. A4).  
It contains the program’s version date and the contact information of its developers. 
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Figure A4. The “Info” worksheet. 

 

4.3. “Run” Worksheet 

The “Run” worksheet (fig. A2) is the GUI component that allows the user to set up and 
run simulations. At the top of “Run” is a text box labeled “Where model files are located.” The 
textbox is used to configure PRISM-2 when it is first installed on a user’s computer; it is 
described further in section 2.  As shown in figure A5, start and end dates for simulations can be 
set by using the controls at the upper left.  The end date must be more recent than the start date. 
The “Time Step” can be set to either 1 hour or 24 hours. PRISM2 simultaneously calculates both 
daily average and hourly SC. The “Sim Time” text box indicates the time stamp that is providing 
the current input values to PRISM-2’s models. 

 

 

Figure A5.  Simulation controls on “Run” worksheet. 
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In the “Step / Run” controls at the upper right in figure A5, “<<Step” and “Step>>,” 
move the current time stamp backward or forward one time step. “Sim Time=Start” sets the 
current time stamp to the simulation “Start” date. “RUN” will start and run a simulation between 
the dates indicated by the simulation “Start” and “End” dates. “Opt All SC,” for the current time 
stamp, will run the optimizer for those gages designated by their “Q13100D Input Option” 
(fig. A2). 

 On a separate worksheet for each gage, PRISM-2 provides detailed numerical and 
streaming graphical information that can be observed during simulations or when incrementally 
stepping through time. This allows the user to examine specific periods and behaviors of interest 
in detail. PRISM-2 also will write input and output data to the “Output” worksheet. Because of 
the added computational load, simulations are slowed when streaming graphics and simulation 
output are generated2. The “Graphs ON” and “Write Output” check boxes of the “Output” 
controls at lower center right in figure A5 allow the user to toggle the streaming graphics on or 
off. The “Clear Output” button erases all data in the “Output” worksheet to allow data from a 
new simulation to be recorded. 

A simulation may be stopped at any time during a run by holding down the “Esc” key, 
after which a pop-up window will appear like that shown in figure A6. Click on the “End” button 
to stop the simulation, then click the “Reset” button shown at lower right in figure A5. The 
“Reset” button activates Excel’s™ automatic calculation feature (autocalc). Because the model 
programmatically manipulates autocalc for performance reasons, aborting a simulation can 
sometimes leave the model in a state where autocalc is not activated. This is remedied by 
clicking the “Reset” button. 

 

                                                           

 

Figure A6. Pop-up window that appears when a simulation is interrupted using the “Esc” key. 
 

  
 

2 The original PRISM was developed in EXCEL™ 2000. It was ported to EXCEL™ 2007 for PRISM-2, where it 
was found to run very, very slowly. It was learned that in EXCEL™ 2007 macros and chart refreshing execute an 
order of magnitude more slowly than in previous versions (see http://www.add-ins.com/ 
Excel%202003%20versus%202007.htm); therefore, PRISM2 EXCEL™ is also an EXCEL™ 2000 application. It 
will run in EXCEL™ 2007 but with greatly diminished execution speed. 

http://www.add-ins.com/Excel%202003%20versus%202007.htm
http://www.add-ins.com/Excel%202003%20versus%202007.htm
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Figure A7 shows that there are a number of input options for the models of each gage. By 
column from left to right, they are 
• “Gage”: denotes the gage options, setpoints, measurements, and predictions in the rows to the 

right in the “Run” worksheet. The "D” (daily average value) and the "H” (hourly value) label 
the “SC SP,” “SCm,” “SCp(m),” “SCp(u),” “dSC(pu-pm),” and “SCm/p+dSC” fields. 

• “Q13100D Input Option”: Options listed below are shown above slider bar. Only “%” is 
shown in figure A7: 
o “%”: percent of historical flow, 
o “cfs”: fixed flow rate in units of cubic feet per second, 
o “usrHyd”: uses the user-defined hydrograph pasted into the UserQ13100D worksheet by 

the user, 
o “LimitD”: the optimizer is engaged when the daily average SC at the gage exceeds the 

SC setpoint set on the “SPs” worksheet (see section 4.4), 
o “LimitH”: the optimizer is engaged when the hourly SC at the gage exceeds the SC 

setpoint set on the “SPs” worksheet , 
o “OptD”: the optimizer is engaged continuously to hold daily average SC at the gage to 

the SC setpoint set on the “SPs” worksheet, and 
o “OptH”: the optimizer is engaged continuously to hold daily average SC at the gage to 

the SC setpoint set on the “SPs” worksheet. 
• “Q13100D Inputs By Option”: the potential user-set Q13100D values input to each gage’s 

model pair. The actual value used depends on the “Q13100D Input Option” setting. 
o “%”: shows the “%” setpoint value set on the “SPs” worksheet. 
o “cfs”: shows the “cfs” setpoint value set on the “SPs” worksheet. 
o “usrHyd”: shows the value given for the current time stamp in the user-defined 

hydrograph on the UserQ13100D worksheet. 
o “Opt”: shows the value computed by the optimizer to meet the SC Setpoint set on the 

“SPs” worksheet. 
• Q13100Du: the input value used according to the “Q13100D Input Option” setting. 
• QTOTDu: total inflow = Q13100Du(τ=24 hrs) + QOTHERm. 
• “SC SP”: Daily and hourly SC setpoints as set on the “SPs” worksheet. The setpoint used is 

per the Q13100D Input Option. 
• “SCm”: measured daily and hourly SC. 
• “SCp(m)”: predicted daily and hourly SC using the measured Q13100D for input. 
• “SCp(u)”: predicted daily and hourly SC using the Q13100Du for input. 
• “dSC(pu-pm)”: =SCp(u) - SCp(m). 
• “SCm/p+dSC”: =SCm + dSC(pu-pm) if SCm is not missing, else = SCp(m) + dSC(pu-pm) . 
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Figure A7. Input options and values for each gage. 

 

4.4. “Setpoints” Worksheet 

Figure A8 shows the the “Setpoints” worksheet, which is the component of PRISM-2’s 
GUI that allows the user to set water level (WL), Q, and SC setpoints. The “WL Gage” control 
shown at top simply provides biasing of the historical WL upwards or downwards in increments 
of tenths of a foot. Using the “Qx Input Option,” the “Q Gage” unregulated Qs can be set to a 
percentage of their historical flow (Qx Input Option = “%”), a constant Q (Qx Input Option = 
“cfs”), or made to use a user-defined hydrograph pasted into the “UserHyds” worksheet (Qx 
Input Option = “usrHyd”).   

In the lower portion of figure A8, the user controls for modulating the regulated flow 
Q13100 are shown. The choice of the Q or SC setpoint used for each gage is made using the 
“Q13100 Input Option.” Under “Q13100D Setpoints” are controls that allow the constant and 
percent valued (Q13100 Input Option = “cfs” and “%”) setpoints to be set for each gage; these 
controls are similar to those for the unregulated flow. The user can also select that a user-defined 
hydrograph, pasted into the “UserHyds” worksheet (Q13100 Input Option = “usrHyd”), be used.   

At right are the controls for setting the SC Daily (D) and Hourly (H) setpoints (Q13100 
Input Option = “LimitD,” “LimitH,” “OptD,” and “OptH”).  These options engage a numerical 
optimizer that automatically calculates, for the given gage, the value of Q13100D needed to meet 
the specified SC setpoint. Using options “LimitD” or “LimitH” will engage the optimizer only 
when the daily or hourly SCm/p+dSC exceeds the specified setpoint. Using options “OptD” or 
“OptH” engages the optimizer continuously. The historical daily and hourly maximum and 
minimum SCs are provided for reference. Maximum and minimum allowed SC setpoints, which 
are constraints on the optimizer derived from the historical daily and hourly maximum and 
minimum SCs, are also given. A “hard-coded” optimizer constraint is that Q13100D is limited to 
a maximum of 15,000 cfs. 
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Figure A8. “Setpoints” worksheet showing headings of the controls and parameters. 

 

4.5. “Database,” “Database2,” and “Output” Worksheets 

The “Database” and “Database2” worksheets contain the time-series data used by 
PRISM-2 to run simulations (fig. A9).  These data are described in table A1 and are derived from 
the raw field measurements. They are augmented by calculated variables whose values are 
calculated by PRISM’s computer code. It is best that the user not alter data in the “Database” 
worksheet. 
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Figure A9. Example of measured data from the “Database” worksheet. 

 

 

Table A1. Descriptions of variables written to the “Output” worksheet during simulations. 

 
The “Output” worksheet contains a record of key variables for a particular simulation run 

(fig. A10). The “Write Output” check box on the “Run” worksheet (fig. A2) must be checked for 
output to be written. The variables written to the “Output” worksheet are explained in table A1. 
The user can copy output values into another Excel workbook for further analysis.  
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Figure A10. Example output from the “Output” worksheet. 

 

 

4.6. “Graphs” Worksheet 

PRISM-2 provides streaming numerical and graphical output for each gage on the 
“Graphs” worksheet (fig. A11), which can be observed during simulations or when incrementally 
stepping through time. This allows the user to examine specific periods and behaviors of interest. 
Some of the functionality of the “Graphs” worksheet is also found on the “Run” worksheet. At 
top left are the “<<Step” “Step>>,” “Sim Time=Start,” “Run,” and “Reset” buttons, which are 
described in section 4.3. Below the buttons is a streaming table listing the Q-related input 
options, and measured and input values of the Qs. At top center and right are streaming graphs 
indicating the input wind direction (DIR), WL, and Qs. 

Scrolling down will reveal data and graphs that are specific to each modeled SC signal. 
For each gage there is a short streaming table listing the selected user Q13100D input option, the 
Q13100D values for each option, and the value of the user-controlled QOTHER. The table also 
lists the control setpoint for the Q13100D optimization option, and measured and predicted 
values of hourly and daily SC. The “Opt SCXXXXD” and “Opt SCXXXXH” buttons are similar 
to the “Opt All SC” button on the “Run” worksheet and will, for the current time stamp, run the 
optimizer for the gage according to the “Q13100D Input Option” settings on the “Setpoints” 
worksheet. The leftmost graph for each gage shows the daily and hourly measured and predicted 
SCs. The graph on the right shows the measured and input Q13100D and QOTHER. The 
graphed parameters are described in table A1 above. 
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Figure A11. “Graphs” worksheet. 

4.7. “3DVis” Worksheet 

PRISM-2’s “3DVis” worksheet provides graphical SC profiles at the South and North 
Ends of the Waccamaw River and Atlantic Intracoastal Waterway study area (fig. A12). It is 
designed to visualize periods of special interest, selectable using the “Start” and “End” date 
controls and initialized using the “Sim Time=Start” button on the “Run” worksheet. On the left 
side of the 3DVis worksheet are data and the controls for operating the 3DVis worksheet. The 
data are a subset of that on the “Run” worksheet and are provided for reference while using the 
3DVis worksheet. The “Vis. Daily or Hourly” control is used to select either daily or hourly SC 
for visualization. The “<<Step,” “Step>>,” “RUN,” “Sim Time=Start,” “RESET,” “Time Step 
(hrs),” and “Graphs ON” buttons and controls are the same as those used in the “Run” worksheet 
and are described in section 4.3. Animations can be started using the “Run” button if the “Graphs 
ON” check box is checked in the “Run” worksheet. 

Figures A12 and A13 show that two plots are created for each of the South and North 
Ends of the study area. The left plots show the SC profile representing the actual historical data 
(when available), and the right plots show the profile predicted by the gage model pairs using the 
user-specified Q13100Du. Note that the predicted profiles are meaningful only if the models are 
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set to use exactly the same input Q13100Du. For example, the plots shown in figures A12 and 
A13 were created using all models with settings “Q13100Du Input Option” = “%” on the “Run” 
worksheet and “Q13100D” “%” setpoints on the “SPs” worksheet = 80 (%). 

 
 

 

Figure A12. The “ 3DVis” worksheet showing specific conductance at the South End of the Waccamaw 
River and Atlantic Intracoastal Waterway study area, South Carolina. Note shortened gage numbers and 
locations. Here, the Q13100Du setting is 300 percent of the historical value. 
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Figure A13. The “3DVis” worksheet showing specific conductance at the North End of the Waccamaw 
and Atlantic Intracoastal Waterway study area, South Carolina. Note shortened gage numbers and 
locations. Here, the Q13100Du setting is 300 percent of the historical value. 
 

 

5. TECHNICAL ASSISTANCE 
Please contact Paul Conrads of the USGS at (803) 750-6140, pconrads@usgs.gov, if you have 
problems with this model.  
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